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we are using Adobe Pho+0ShoP ELEmMEeNn+s

Today we will use different Blending Modes, the Threshold Filter, Color
Halftones, Gaussian Blur, Gradients, and more to create an awesome image

To Make photos look their best
- Create amazing composites with easy-to-use tools
« Brush away wrinkles, unwanted objects, and other flaws
- Make selections in a snap so you can easily adjust specific areas of a
photo
- Easily adjust skin tones for a more natural look
- Fine-tune exposure with color curves adjustments
and the enhanced Brightness/Contrast control
To Do more with photos
- Start creating quickly, no experience necessary
- Express your ideas in customizable layouts
- Create photo books with greater ease and flexibility
« Entertain friends with custom slide shows and interactive web galleries
- Share with family and friends using a variety of fun options

To Easily find and view all photos and video clips
- Instantly download photos from your camera
- Categorize photos and video clips with easy-to-use visual tags
« Group photos into convenient Albums
- Develop creations more quickly by gathering the photos you need for a
specific project in one place
- View and organize your photos quickly, even when your library grows
to include thousands of photos

¢ ADOBE

' Photoshop
: Elements.
’8 .
i i‘;ﬁmk ﬁ :.Eg &{f’
* Photoshop &y’
i Elements © il L\

Adobe® Photoshop® Elements 6
Version 6.0.(20080307.m.527@431481)




A—— @ Photoshop Elements File Edit Image Enhance Layer Select Filter View Window Help

—¥ = 4
- 2

| e

"y

- — ' - — Show All
GG * DCP_0660.JPG @ 25% (RGB/B) = % ~

9391 Inches x 6.26 1 Incnes 230

25% 9391 irches x 6261 inches (230 ppd

You should be
familiar with Adobe
Photoshop
el e ' Elements before
= | viewing this project.
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Full Edit workspace ) needed

A. Menu bar B. Workspace buttons C. Toolbox D Project Bin E. Palettes F. Palette bin G. Active image area

1y Palecie Bin
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Pattern . Mode: Normal Opacity: 100% Tolerance: 32 ./ Anti-alias .~ Contiguous  All Layers

Menu bar Contains menus for performing tasks. The menus are organized by topic.
For example, the Enhance menu contains commands for applying adjustments to an
image.

Workspace buttons Moves you between the Guided Edit, Quick Fix, and Full Edit
workspaces. These buttons change according to the current workspace.

Toolbox Holds tools for editing images.

Options bar Provides options for the tool you select.

Project Bin Displays thumbnails of opened images, and lets you easily manage them.
Palettes Help you monitor and modify images.

Palette Bin Helps you organize the palettes in your work area.

Note: To view the area behind open photos, including other open applications, uncheck
Photoshop Elements > Preferences > Fill Workspace Background. To fill the workspace with a
gray backdrop, select the Fill Workspace Background. option. Do NOT change this.



Toolbox overview

-

@ Navigation and
measuring tools

ks, Move (V)
= &, Zoom (2)
= 'Y Hand (H)

= _# Eyedropper (1)

© Selection tools
m ' Rectangular
Marquee (M)
.+ Elliptical Marquee (M)

L Q Lasso (L)
&2 Magnetic Lasso (L)
% Polygonal Lasso (L)

® 35 Magic Wand (W)

B %\ Quick Selection (A)
& Selection Brush (A)

@ Type tools

® '|" Horizontal Type (T)
1'I‘VerticaIType (T
"1 Horizontal Type
“= Mask (T)
1“3'{‘ Vertical Type
“=Mask (T)

@® Croptools

= 2 Crop (C)

u %7 Cookie Cutter (Q)
= [, Straighten (P)

@ Retouching tools
® @ Red Eye Removal (Y)
"y Spot Healing
Brush (J)
& Healing Brush (J)

= XL Clone Stamp (S)
&, Pattern Stamp (S)

= &/ Eraser (E)
&7 Background Eraser (E)
9 Magic Eraser (E)
= & Blur (R)
A Sharpen (R)
Y2 Smudge (R)
® . Sponge (O)
R Dodge (O)
&= Burn (0)

@ Painting and
drawing tools

= ¢ Brush (B)
& Pencil (N)

I Impressionist
Brush (B)

& Color Replacement (B)
u ¢ Paint Bucket (K)
® M Gradient (G)

@ Shape tools

=l Rectangle (U)

@ Rounded
Rectangle (U)

@ Ellipse (L)
@ Folygon (U)

\ Line (U)

W Custom Shape (U)
k- Shape Selection (U)

The ToolLbox
Tools



About the toolbox

Use tools in the toolbox to select, edit, and view images; some tools let you paint, draw, and type.
The toolbox appears on the left side of the Full Edit and Quick Fix workspaces. In the Full Edit
workspace, you can move the toolbox by dragging the gripper bar at the top of the box. You must
select a tool in the toolbox before you can use it. Once selected, the tool is highlighted in the
toolbox, and optional settings for the tool appear in the options bar, which is located below the
shortcuts bar at the top of the workspace. Some tools in the toolbox have additional tools beneath
them. These are called nested tools. A small triangle at the lower right of the tool icon signals that
there are nested tools. When you select a tool, any additional nested tools appear in the options bar.

Note: You cannot deselect a tool once you select a tool, it remains selected until you select a different tool. For
example, if you’ve selected the Lasso tool, and you want to click your image without selecting anything, select
the Hand tool.

You can view information about any tool in the toolbox by positioning the pointer over it. The name
of the tool appears below the pointer, this is called the tool tip. You can click a link in some tool tips
to see additional information about the tool.



About foreground and
background colors

You apply the foreground color when you
paint with the Brush or Pencil tools, and when
you fill selections with the Paint Bucket tool.
The color you apply to the Background layer
with the Eraser tool is called the background
color . You can see and change the
foreground and background colors in the two
overlapping boxes at the bottom of the
toolbox. The top box is the foreground color,
and the bottom box is the background color.
The foreground and background colors are A
also used together by the Gradient tool and

some special effects filters.
B

You can change the foreground or background
color in the toolbox by using the Eyedropper Foreground and background color boxes in toolbox

A. Foreground color box B. Click to use default colors (black and white)
tOOII the COIOr Swatches palettel or the COlOF C. Click to switch the foreground and background colors D. Background

Picker. color box



Choose a color with the Eyedropper tool

The Eyedropper tool makes it easy to copy a color
without having to select a swatch. It copies, or
samples, the color of an area in your photo to set
a new foreground or background color. You can
sample from the active image, from another open
image, or from your computer’s desktop.

[F\I 8 Select Filter View Wi

New >

Click the Lock Transparency icon at the #Delte Laver
top of the Layers palette to lock the transparent | Laperse .
areas of the layer, so that no painting occurs in “La <
them. Click the icon again to unlock. e oot
Note: For type and shape layers, transparency | smalty Laer
is locked by default and cannot be unlocked

Arrange >

without first simplifying the layer. vergeDown

Merge Visible O ®8E
Flatten Image



About patterns

You can paint a pattern with the Pattern stamp tool or fill a
selection or layer with a pattern that you choose from the

pattern libraries. Photoshop Elements has several patterns
you can choose from.

To customize your images, or to make one-of-a-kind
scrapbook pages, you can create your own patterns. You can
save patterns that you create in a library, and then load
libraries of patterns using the Preset Manager or the Pattern
pop-up palette, which appears in the options bar of the
Pattern Stamp tool and the Paint Bucket tool. Saving patterns
allows you to easily use a pattern in multiple images.

Find Edges

The Find Edges filter identifies areas of the image with
significant transitions and emphasizes edges. Like the
Trace Contour filter, Find Edges outlines the edges of an
image with dark lines against a white background and is
useful for creating a border around an image.

Note: After using filters like Find Edges and Trace
Contour that highlight edges, you can apply the Invert
filter to outline the edges of a color image with colored
lines or a grayscale image with white lines.

blending mode

A feature that controls how pixels in an image
are affected by a painting or editing tool. The
blend color is applied to the base (original) color
to produce a new color, the result color. When
applied to layers, a blending mode determines
how the pixels in a layer blend with pixels in
layers beneath it.

adjustment layer

A layer that lets you apply color and tonal
adjustments to your image without permanently
changing pixel values. Use adjustment layers to
experiment with color and color tones. You can
think of an adjustment layer as a veil through
which the underlying layers are seen.



About Blending
Modes

Blending modes control how Linear Burn

pixels in an image are affected BELEIEEET

by a painting or editing tool. It's

helpful to think in terms of the _ ) g —r
following colors when visualizing ‘ Dissolve
a blending mode’s effect: i : oaren

e The base color is the original
color in the image.

e The blend color is the color
applied by the painting or

editing tool.

e The result color is the color
resulting from the blend.

Lighter Color

Qwerlay
Soft Light
Hard Light
Wivid Light
Linear Light
Pin Light
Hard hix

Difference
Exclusion

Hue
Saturation
Color
Lurninosity

Color Burn
Linear Burn
Darker Color

Lighten

Screen

Color Dodge

Linear Dodge (Add)
Lighter Color

Opacity:

Soft Light

Hard Light Lock: .
Vivid Light

Linear Light

Pin Light

Hard Mix

Difference
Exclusion

Hue
Saturation
Color
Luminosity

32%




About Blending Modes

You can choose any of the following blending modes from the Mode menu in the options bar:

Normal Edits or paints each pixel to make it the result color. This is the default mode. (Normal mode is called Threshold when you’re working with an image in bitmap or
indexed-color mode.)

Dissolve Edits or paints each pixel to make it the result color. However, the result color is a random replacement of the pixels with the base color or the blend color,
depending on the opacity at any pixel location. This mode works best with the brush tool and a large brush.

Darken Looks at the color information in each channel and selects the base or blend color—whichever is darker—as the result color. Pixels lighter than the blend color are
replaced, and pixels darker than the blend color do not change.

Multiply Looks at the color information in each channel and multiplies the base color by the blend color. The result color is always a darker color. Multiplying any color by
black produces black. Multiplying any color by white leaves the color unchanged. When you’re painting with a color other than black or white, successive strokes with a
painting tool produce progressively darker colors. The effect is similar to drawing on the image with multiple felt-tipped pens.

Color Burn Looks at the color information in each channel and darkens the base color to reflect the blend color. Blending with white produces no change.

Linear Burn Looks at the color information in each channel and darkens the base color to reflect the blend color by decreasing the brightness. Blending with white produces
no change.

Lighten Looks at the color information in each channel and selects the base or blend color—whichever is lighter—as the result color. Pixels darker than the blend color are
replaced, and pixels lighter than the blend color do not change.

Screen Looks at each channel’s color information and multiplies the inverse of the blend and base colors. The result color is always a lighter color. Screening with black leaves
the color unchanged. Screening with white produces white. The effect is similar to projecting multiple photographic slides on top of each other.

Color Dodge Looks at the color information in each channel and brightens the base color to reflect the blend color. Blending with black produces no change.

Linear Dodge (Add) Looks at the color information in each channel and brightens the base color to reflect the blend color by increasing the brightness. Blending with black
produces no change.

Lighter Color Compares the total of all channel values for the blend and base color and displays the higher value color. Does not produce a third color, which can result from
the Lighten blend, because it chooses the highest channel values from both the base and blend color to create the result color.

Overlay Multiplies or screens the colors, depending on the base color. Patterns or colors overlay the existing pixels while preserving the highlights and shadows of the base
color. The base color is mixed with the blend color to reflect the lightness or darkness of the original color.



About Blending Modes

Soft Light Darkens or lightens the colors, depending on the blend color. The effect is similar to shining a diffused spotlight on the image. If the blend color is lighter than
50% gray, the image is lightened. If the blend color is darker than 50% gray, the image is darkened. Painting with pure black or white produces a distinctly darker or
lighter area but does not result in pure black or white.

Hard Light Multiplies or screens the colors, depending on the blend color. The effect is similar to shining a harsh spotlight on the image. If the blend color is lighter than
50% gray, the image is lightened. This is useful for adding highlights to an image. If the blend color is darker than 50% gray, the image is darkened. This is useful for
adding shadows to an image. Painting with pure black or white results in pure black or white.

Vivid Light Burns or dodges the colors by increasing or decreasing the contrast, depending on the blend color. If the blend color (light source) is lighter than 50% gray,
the image is lightened by decreasing the contrast. If the blend color is darker than 50% gray, the image is darkened by increasing the contrast.

Linear Light Burns or dodges the colors by decreasing or increasing the brightness, depending on the blend color. If the blend color (light source) is lighter than 50%
gray, the image is lightened by increasing the brightness. If the blend color is darker than 50% gray, the image is darkened by decreasing the brightness.

Pin Light Replaces the colors, depending on the underblend color. If the blend color (light source) is lighter than 50% gray, pixels darker than the blend color are
replaced, and pixels lighter than the blend color do not change. If the blend color is darker than 50% gray, pixels lighter than the blend color are replaced, and pixels
darker than the blend color do not change. This mode is useful for adding special effects to an image.

Hard Mix Reduces colors to white, black, red, green, blue, yellow, cyan, and magenta—depending on the base color and the blend color.

Difference Looks at the color information in each channel and subtracts either the blend color from the base color or the base color from the blend color, depending on
which has the greater brightness value. Blending with white inverts the base color values; blending with black produces no change.

Exclusion Creates an effect similar to, but lower in contrast, than the Difference mode. Blending with white inverts the base color values. Blending with black produces no
change.

Hue Creates a result color with the luminance and saturation of the base color and the hue of the blend color.

Saturation Creates a result color with the luminance and hue of the base color and the saturation of the blend color. Painting with this mode in an area with zero
saturation (a neutral gray area) causes no change.

Color Creates a result color with the luminance of the base color and the hue and saturation of the blend color. This preserves the gray levels in the image and is useful
for coloring monochrome images and for tinting color images.



Mazing )

Apply the Threshold filter ﬁm@l&

The Threshold filter converts grayscale or color images into high-contrast, black-and-white images.
You can specify a certain level as a threshold. All pixels lighter than the threshold are converted to
white; and all pixels darker are converted to black. The Threshold command is useful for determining
the lightest and darkest areas of an image.

1. Select an image, layer, or area.
2. Do one of the following:
o Choose Filter > Adjustments > Threshold.

o From the Layers palette or Layer menu, create a new Threshold adjustment layer, or open an
existing Threshold adjustment layer.
The Threshold dialog box displays a histogram of the luminance levels of the pixels in the
current selection.

3. Select Preview and do any of the following:

o To change the image to black and white, drag the slider below the histogram until the
threshold level you want appears at the top of the dialog box, and click OK. As you drag, the
image changes to reflect the new threshold setting.

o To identify a representative highlight, drag the slider to the right until the image is pure
black. Then drag the slider back until some solid white areas appear in the image.

o To identify a representative shadow, drag the slider to the left until the image is pure white.
Then drag the slider back until some solid black areas appear in the image.

4. (Optional) To return to default settings, hold down Option and click Reset.
5. (Optional) Click Cancel to close the Threshold dialog box without applying changes to the image.



JOME WAYS TO GET RID OF UNWANTED PIXELYS

Use the Background Eraser tool

The Background Eraser tool turns color pixels to
transparent pixels so that you can easily remove an
object from its background. With careful use, you can
maintain the edges of the foreground object while
eliminating background fringe pixels.

The tool pointer is a circle with a cross hair indicating
the tool’s hotspot . As you drag the pointer, pixels
within the circle and of a similar color value as the
pixel under the hotspot are erased. If the circle
overlaps your foreground object, and it doesn’t
contain pixels similar to the hotspot pixel, the
foreground object won’t be erased.

Use the Magic Eraser tool

The Magic Eraser tool changes all similar pixels when
you drag within a photo. If you're working in a layer
with locked transparency, the pixels change to the
background color; otherwise, the pixels are erased to
transparency. You can choose to erase contiguous
pixels only, or all similar pixels on the current layer.

Use the Magic Extractor

Use the Magic Extractor to make accurate selections
based on the appearance of foreground and
background areas that you specify. You can specify
these areas by placing colored marks in the areas you
want to select. After you mark the areas and close
the dialog box, only the foreground area appears in
the photo.

Use the Eraser tool

The Eraser tool changes pixels in the image as you
drag through them. If you're working in the
Background layer or in a layer with locked
transparency, erased pixels change to the background
color; otherwise, erased pixels become transparent.
Transparent pixels are indicated by the transparency
grid.



Keys for painting and brushes: Result

Shortcut

Switch to Eyedropper tool

Any painting tool or shape tool + Option (except Impressionist Brush)

Select background color

Eyedropper tool + Option-click

Set opacity, tolerance, or exposure for painting

Any painting or editing tool + number keys (for example, 0 = 100%,
1 = 10%, 4 and 5 in quick succession = 45%).

Cycle through blending modes

Shift + + (plus) or - (minus)

Fill selection/layer with foreground or background color

Option + Delete (Backspace), or Command + Delete (Backspace)

Display Fill dialog box

Shift + Delete (Backspace)

Lock transparent pixels on/off

/ (forward slash)

Connect points with a straight line (draw a straight line)

Any painting tool + Shift-click

Delete brush

Option-click brush

Decrease/increase brush size

[ or]

Decrease/increase brush softness/hardness in 25%
increments

Shift + [ or ]

Select previous/next brush size

, (comma) or . (period)

Select first/last brush

Shift + , (comma) or . (period)

Display precise cross hair for brushes

Caps Lock

Helpful
shortcuts




Find an image of a human
(or teacher) with little or
no background

Double-click on background
layer to unlock it

If your image is about 800
pixels wide by 600 pixels in height,
skip the next step, otherwise:

Hold the Command key d6 and
click the new layer button to
create a new layer below layer O.

Turn off the eye icon on layer O
and paint the new blank layer your
choice of a background color.




Background

New Layer

Name: 0K
Group With Previous Layer

Mode: Normal Opacity: 100 %

Background

v Layers

Normal Opacity: 100%

We will start with two scenarios to choose Lock: [
how you complete the project




Open a new document and make it 800
pixels wide by 600 pixels tall. We use 72
pixels per inch and a white background
Edit

Filter View Window

Blank File...
Image from Clipboard

Select

Enhance

Photoshop Elements

Image Layer

~ _Open... #0

Browse with Bridge

Open Recently Edited File = Photomerge® Group Shot...

Duplicate... Photomerge® Faces...
Photomerge® Panorama...

Close F$W

e ][IKI]ID THIS STIEP

Name your project appropriately “
Preset: Web

[IF YOUR IMAGIE

Width: pixels

Height: pixels

- I ABOUT

Color Mode: RGB Color

Image Size:

o00 BY 600

Background Contents: White




Use the Select foreground color, then use the Paint Bucket or the keyboard shortcut (Option + Delete)

PN

(@ HEAD_ADE_09_00302.png @ 66.7% (Layer 1, RGB/8%)
» Effects

v Layers

Normal Opacity: 100%
Select foreground color: S T i Lock:

: V]
® Learn more about: Choosing Colors - 0K - .
» 3 ¥ | Layer 0

R:
G:
B:

# 0df739

Only Web Colors




Get rid of any extra
background pixels on the
image layer by one of the

following methods

Filter View Window Help
All #A

Deselect #D
Reselect 0D

HEAD_ADE_09_00302.png @ 66.7% (Layer 0, RGB/8*)

All Layers
Deselect Layers
Similar Layers

Feather... D
Refine Edge...
Modify >
Grow

Similar

Load Selection...
Save Selection...
Delete Selection...

1.Use t
2.Use t
3.Use t
4.Use t
5.Use t

ne Background Eraser tool
ne Magic Eraser tool

ne Eraser tool

ne Quick Selection tool

ne Magic Extractor

%, Quick Selection Tool A

“+ " Selection Brush Tool A

We used the Quick Selection
Tool and proceeded to select the
part of the image we wanted to
save inside the marching ants.

Next we went to the Select

L a8 Filter View Window Help

All A

#D
3D

8! b LEAD_ADE_09_00302.png @ 66.7% (Layer 0, RGB/8%)

Deselect
Reselect
Inverse

All Layers
Deselect Layers
Similar Layers

Feather... X &D
Refine Edge...
Modify >

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

Menu > Inverse to switch our
selection to the unwanted pixels
and pressed Delete.

Ve Deselected the marching
ants by pressing Command + D

Grow
Similar

Load Selection...
Save Selection...
Delete Selection...




& thresl.psd @ 100% (Background, RGB/8)

If you created a new
Blank File, select the
Move Tool and drag
the image layer on
top of the now
colored layer.

Your Layer Palette should look like the one shown here



Either way, you should be here

Original image with New Blank File 800px wide
no size adjustment by 600px in height

thresl.psd @ 66.7% (Layer 0, RGB/8)




»~» On the original image layer, go to
Filter > Adjustments > Threshold

Filter - | b b P ®

g8 O EDIT CREATE SHARE

¥| Full [ﬁ Quick % Guided I . A\ \ /
OITe AMmera ortio A e
AD ADE 09 00302.ong @ 66.7% (Layer 1, RGB/8 N | 22 NWI | 1!} ‘K&‘
Adjustments > qualize » Effects s ey Jey i\ ‘
A dll | d [

v Layers
n n ; Normal Opacity: 100%
> OKE NsSte - X _
Disto Threshold... : w
< Yhoto - b t

7 Layer 0

- o N
) B ; "‘..‘:‘-4-'.:1 . C C
W ~ o Layer 1
.
; / \J ~
» g - . r] &
3 » Effects
s
, =
® Learn more about: Threshold N tock W

0 .-
5, - — 4‘
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7 rul 7 quik BF Guided

» Effects

v Layers

HEAD_ADE_09_00302.png @ 66.7% (Layer 0, RGB/8*)

Normal

_ 9 w 2
Threshold R " Y

® Learn more about: Threshold [ oK " - R © |a [Bere

Cancel

Threshold Level: -

Threshold

® Learn more about: Threshold

Threshold Level:

Adjust the Threshold Level to

meet your image needs.
We ended up with 105

Cancel

v Preview




HEAD_ADE_09_00302.png @ 66.7% (Layer O, RCB/8%)
» Effects

Caussian Blur v Layers

Normal

[ Ok N 2aE @ N

s 4 >
 Preview 7 : N lm

ST | Next, go to the
Radius: IR pixel N Filter Menu and
' ' | select BLUR >
Gaussian Blur.
We used a small
radius of 1.0

pixels
Using a small Gaussian Blur tends to smooth rough edges




B Ful [ﬁ Quick %Z Guided

» Effects

HEAD_ADE_09_00302.png @ 66.7% (Levels 1, Layer Ma...

v Layers

Normal Opacity: 100%

Lock: &

© FD Levels 1
2

® Learn more about: Levels

— Command # + L or Enhance
= } Menu > Adjust Lighting >
C Levels opens the Levels dialog

Channeli RGE

Input Levels:

e Adjust
Levels as
B
. s needed

29

Output Levels:

Levels dialog box
A. Channels to adjust color B. Shadow values C. Middle tones D.
Highlight values




® M O HEAD_ADE_09_00302.png @ 66.7% (Layer 0, RGB/8%)

Normal
Dissolve

Darken

= m\&ll \O

Lighten

Screen g \ l 3 ()
Color Dodge

Linear Dodge (Add)

Lighter Color

Overlay
Soft Light
Hard Light
Vivid Light
Linear Light
Pin Light
Hard Mix

Difference
Exclusion

Hue
Saturation
Color
Luminosity

66.67% 7.319 inches x 11 inches (72 ppi)




»» Add new layer between existing
+» Choose the Gradient Tool and use
the Linear Gradient Black 2 White

Photoshop Elements

File Edit Image Enhance Layer Select Filter View Window Help

Gradient Editor

79 i =
/78

Hold the Shift
key while

l‘l S e e dragging the

N gradient from
; - top to bottom
5 | ——— so it fills evenly

Color: [:[E Location: % Delete




Fll¢ View Window Help
Gaussian Blur B F
Filter Gallery... _ Change CO|OI‘
Correct Camera Distortion... Halftone to Max

HEAD_ADE_09_00302.png @ 66.7% (Layer 2,

AP % Radius |10 Pixels
rtistic 4
Blur > and set all
Brush Strokes &
Distort > Channels to 0
Noise = #
Pixelate > olor Halftone...
Render B Crystallize...
Sketch = Facet
Stylize k- Fragment
Texture »  Mezzotint... Color Halftone
Video = Mosaic...

\ /ﬁ
/ N/

Screen Angles (Degrees): . Cancel

v

Digimarc

0 (' Default
0

Channel 1:

Channel 2:

0

Channel 3:

Channel 4:

On the new Gradient layer, go to
Filter > Pixelate > Color Halftone



» Effects

v Layers

dak. A 4CCRLGI0R

.

b Multiply Opacity: 100%
¥ 2 Lock: [l ~

Mr. K's Technology

66.67% 7.319 inches x 11 inches (72 ppi)
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